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By Caprice Castano Templates are pre-set forms that can be anything from a business card to a full color business report with graphs. Templates have formats set with images or text already laid out in the document. They can be something as simple as a straight-line stencil you wish to transfer to another object or a multipage document you can
personalize with your own text and information. Designed to be personalized and printed, templates are a great time-saver for many projects. Locate and access the template you wish to use. If you have a program for home or business that contains templates, access the program and be sure any information you need to add in the template is
complete. If you are printing a template from a website, download or open the template and be sure you have personalized it if necessary. Click on the "File" tab at the top left corner of the template document. In the drop-down menu that appears, locate and click "Print Preview." This opens a new window that shows exactly what the document will
look like when it is printed. Check to be sure all the elements are properly placed and within the page margins. Click "Close" at the top menu bar of the print preview window. Adjust any elements that were outside the margins by clicking "Page Setup" on the "File" tab. On the menu that opens, adjust the margins to widen the printable area, check to
be sure footers and headers are correct if you have any. You can also select the "Layout" tab to change the document orientation. When you have made your changes, repeat Step 2 and preview your document. Print the template when your changes are set by clicking the "File" tab and choosing "Print." This will send the document to the printer to
produce your template. Just about everyone knows that you can buy a wide range of self-published gear over at CafePress, but did you know that you could create your own without having to sign up for a shop? Recently, my friend Tina complained that she couldn't find any shirts for gay homeschoolers. No problem, I replied. It's easy to make your
own. Follow the jump for step-by-step instructions on how-to-do-it.CafePressLoyal Reader John Steinbeck points out that Zazzle.com offers personalized US Postal stamps as well as many of the same customizable products as CafePress.Design the Image. Fire up Photoshop Elements or your favorite image editor and create your design. Make sure to
use full color and a resolution of at least 150-300 pixels per inch. Save using TIFF or some other similar high-quality format.Point your browser to CafePress. This page lets you select the product you want to customize.Create a T-shirt. Locate the T-Shirts image and click Create It! A second product choice page opens. For this example, let's stick with
the Custom White T-Shirt choice. Again, click Create It!Add your picture. Click the Browse button. When the open file dialog appears, navigate to the custom art you created in the first step. Select and open it. The name of the file will appear in the box next to the Browse button. Click Next: Add & Preview.Wait. An Upload progress window appears.
Wait for the file to upload.Order your T-Shirt Click Review and Order. Select a size and a quantity and then click Add to Cart. Your shirt is ready for purchase. If you've ever wondered how your favorite clothing store achieves those perfectly stacked piles of tops, the answer is actually pretty simple: with the help of the best T-shirt folders. And no, I'm
talking about the retail associates. The secret to getting boutique-worthy shelves and dresser drawers is a T-shirt folding board. It not only makes your piles of tees look pristine, but neatly folded clothing can be a serious space-saver, too. Best of all though, a T-shirt folding board is a faster, easier, and more efficient way to fold a variety of tops. But
not all folding boards are the same, and depending on your wardrobe, different styles and added features may be better suited to fit your desired folding preference. For instance, although any T-shirt folding board can conquer T-shirts with ease, some can also help fold blouses, thick sweaters, or kids clothing. No matter which type of board you
choose, the best T-shirt folders can help turn a heaping load of laundry into a tidy stack quickly and effortlessly. So whether you're a novice to the art of folding tees or retail veteran, these boards are just the thing to help you tame and tidy your wardrobe.1This Three-Step T-Shirt Folder That Has Cult-Following On AmazonOhuhu Clothes Folder, $13,
Amazonlt's easy to see why this is the most popular folding board on Amazon: In three simple steps this board folds anything from T-shirts to pants to sweaters. Unlike a lot of similar boards on the market, this board features adjustable hinges so that you can easily fold thinner or thicker garments. Folded up it's 11 inches by 9 inches, 1.2 inches thick,
and features a hook that makes it super easy to store. One Amazon user even left this glowing review, "Honestly I got this as a joke after seeing Sheldon use one on "The Big Bang Theory." I was really surprised how well this works and how simple it is to use! Now I use this Ohuhu Clothes Folder every time I do laundry!"2This Pack Of Different Sized
Folding Boards — Because Sometimes Size MattersEzPacking Travel Folding Boards, $14 (3 Pack), AmazonSometimes, one size doesn't fit all and that's when this pack of boards comes in handy. While it may not have the ease of a self-folding board, they do have folding instructions printed on them and the different sized boards allow you to get the
perfect fold whether you're working with kids clothing or a chunky sweater. Pro tip: fold thicker clothing on the widest board. This will distribute the bulkiness out so that, for instance, a tall pile of sweaters will stay neatly stacked instead of toppling over. The medium board will be best suited for shirts, while the narrowest is great for tees and kids
clothing. The folders are lightweight, flexible, and super thin, so they aren't just easy to slide into a drawer at home but they're perfect for slipping into luggage too.3This Sturdy Folding Board That Retail Professionals Swear ByHousehold Essentials Folding Board, $9, AmazonThis sturdy plastic board is style of T-shirt folder that most retail
professionals use — and for good reason, too. It's simple, compact, and the handle makes it easy to slide out of a folded top. This one even comes with directions engraved on it for easy reference. It's a little more than 12 inches tall and 8.5 inches wide, so it's ideal for tees and collared shirts. One Amazon reviewer even vouched for it saying, "Great
size. Use this in our tshirt shop every day. Perfect fit to fold."However, if you're looking for something better suited for sweaters, I recommend opting for the same style of board in a larger size. Bustle may receive a portion of sales from products purchased from this article, which was created independently from Bustle's editorial and sales
departments. To coincide with the launch of Kate Moross's new T-shirt range and lookbook, she's kindly giving away one of her Isometric T-shirts in a new, limited green colourway to one lucky reader. We caught up with Kate who told us a little more about the range:"After over five years of designing and making T-shirts for my clothing label I
decided to expand the range. This september we launched the Kate Moross online shop with a redesigned store, new stock and a brightly coloured, somewhat goofy lookbook," she says.The limited edition green Isometric T up for grabs "We've added new designs and lots of colour to the range as well as re-printing the classic KM T-shirts. The label
now consists of the signature tees in simple black and white, and the limited edition shirts (complete with gold labels) in a rainbow of colours and shades. We have also added a range of unisex triangle jewellery and accessories, as well as two new sweatshirts. All these new items have joined the back catalogue of prints, posters and vinyl, which
expands yearly."To be in with a chance of winning, simply tweet @computerarts with the hashtag #freemorosstee.The closing date for entries is 4pm UK time on Friday 7 October.Good luck!www.katemoross.comLookbook Once you're ready to print your T-shirts, options abound. And most experts have definite opinions about which way is the best.
Many people use traditional screen-printing, which involves pushing ink through a mesh screen to transfer an image onto a shirt. One newer technique is "direct to garment" printing, in which a large inkjet printer prints the image directly on the tees. "It doesn't make much difference how you do it," says Peter Rinnig, owner of QRST's , a T-shirt
printer in the Boston area. "Just research what's best and most cost-effective for you." John Earle has always stuck with traditional screen-printing for Johnny Cupcakes , a T-shirt company in Hull, Massachusetts, and he has no complaints. "It's been around the longest and is the most reliable," he says, "although this year, I plan on testing out a few
new methods--dye, enzyme washes, cut and sew, embroidery, direct-to-garment printing and more." If you plan to purchase your own equipment, you can get a used screen-printer for $5,000 to $10,000. Direct-to-garment printers cost considerably more--roughly $20,000 for a good one, according to Rinnig. It's a newer technology, and only a handful
of companies are making the machines. If you use a print shop, you don't have to worry about equipment. But you do need to make sure you're satisfied with the quality. When shopping for a printer, consider working with a company like QRST's that does all its work in-house. Some printers actually serve as "brokers," outsourcing the printing to
someone else. If that's the case, you lose some control over the process. Rinnig also advises caution if you're considering an online print shop, for the same reason. Some websites let you upload images for printing and even selling directly on their sites, but not all of them print the shirts themselves. "The unwitting customer goes to [one of these
sites], and it's actually out of those websites' hands because they're not doing the printing," he says. QRST's prints all orders itself, as does Spreadshirt Inc. , an online print shop in Greensburg, Pennsylvania. Jana Eggers, the CEO, agrees that a level of caution is wise when hiring a printer--not only for the quality of the shirts, but also for the quality
of customer service you receive. "There's a big difference between different printers and printing techniques, as well as the logistics and customer service," says Eggers. Ultimately, putting the effort into selecting the best printer and printing technique will serve you well. Be patient throughout this process; it may take time to find the one you like.
"There's a lot of technology that can help you be responsive to trends and make good money," adds Eggers, "but it's not something where you just flip the switch and get going."” )(n.) (1) Something that establishes or serves as a pattern for reference. (2) A plastic or paper diagram that you can put on your keyboard to indicate the meanings of different
keys for a particular program. (3) A sheet of plastic with menus and command boxes drawn on it that you place on top of a digitizing tablet. You can select commands by pressing the digitizing tablet’s pen against a command box or by positioning the cursor over a box and pressing one of the cursor keys. (4) In spreadsheet and database applications, a
template is a blank form that shows which fields exist, their locations, and their length. In spreadsheet applications, for example, a template is a spreadsheet in which all the cells have been defined but no data has yet been entered. (5) In some word processing applications, template is used in place of style sheet. (6) DOS uses the term template to
mean command buffer. (7) A shortened term for a biometric reference template.
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